MDT Training Report

MDT Training #2 for EBRD Project (March 2016)
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Introduction

Within Mongolia, companies whose business practices impact the land and alter the natural state of the
environment are required by law to offset those impacts. Companies may work directly with Ministry of
Environment to create an extensive and detailed offset plan or they can follow Section 3.3.6 of the
Mongolian Offset Regulation (MOR) to fulfil offset requirements through compensation. Following this
section, companies calculate required offset measures in three main steps: 1) Identify the area that is
likely to be affected by the proposed project (i.e. map the development footprint and its direct
supporting infrastructures, delineate an impact area, and determine the magnitude of these impacts); 2)
Use this impact area to calculate the total offset units necessary to meet the offset regulation; and 3)
Calculate total yearly offset compensation value. For each step, the MOR defines methods for
calculating and fulfilling these requirements. In order to follow these steps, it is however necessary to
be well versed in using GIS and fully understand all data used in the analysis. Without this knowledge,
the regulation can be difficult to implement leading to inconsistencies in those trying to follow the law.

To meet this implementation gap, The Nature Conservancy (TNC) in partnership with the Mongolia
Ministry of Environment and Green Development (MEGD) produced a series of documents and GIS tools
to provide companies with the ability to easily and efficiently determine their offset compensation
requirements. Overall this effort produced the Mitigation Design Tool (MDT) which is now available as a
desktop, ArcGIS application (MDT-Desktop) and as an open-source, internet application (MDT-Web).
The MDT-Desktop is a toolbox with a collection of customized tools supporting the MOR. It has four
main toolsets; Land Disturbance and Impact Tools, Offset Tools, Supplementary Avoidance Tools, and
Update Tools. The Land Disturbance and Impact Tools assist users in following standards set for creating
LDs such as projection and attribution and then allow for using these LDs to create a project impact
dataset. The Offset Tools use the project impact dataset to derive an offset cost report and identify
potential offset locations. The Supplementary Avoidance Tools allow users to relatively compare
potential offset costs for either leases and or planned land disturbances. By providing these tools, users
can look at ways to potentially limit their offset costs while also avoiding important landscapes and
habitat within Mongolia. Finally the Update Tools help users stay current with the application database
without having to reinstall the MDT application.

The web-based mitigation tool allows users via the Internet to produce data and reports necessary to
comply fully with the MOR. Users will be required to create input data (i.e. land disturbances) and
upload these data in a shapefile format. This document describes how to accomplish this task using
QGIS however any available mapping or design software can be used which allows for data to be
exported in a shapefile format. The input data are processed by a remote TNC server with the web
application emailing users a zipped file containing a raster dataset representing the project impact area,
an html file containing the MDT offset report, and all supporting shapefiles (i.e. offset site selections and
input land disturbances). None of the data uploaded by the users is saved to the server except
temporarily during the processing of data. A full description of the MDT-Web and how to use it is
available in the MDT-Web Help documentation. Both applications and their respective documentation
can be found at the Mongolia Mitigation Design Tool Web Portal.

This endeavour was part of a larger effort of building capacity within MEGD to support landscape-level
conservation in the southern Gobi and was directly financed by the European Bank for Reconstruction
and Development (EBRD) Shareholders Special Funds. Specifically TNC assisted MEGD and other
stakeholders in the identification, review, assessment, implementation, and monitoring of mitigation
and other conservation measures. Four main tasks were identified within this project: 1) conduct an
analysis of habitat connectivity of Asiatic Wild Ass (Equus hemionus, or khulan) in the Eastern Gobi



Desert region; 2) create the mitigation design tool (MDT); 3) assess alternatives and logistical constraints
of regional traffic; and 4) provide training for a) performing habitat connectivity analyses, b) using MDT,
and c) assessing regional soil conditions in the mineralized zones of the Gobi Desert.

This report focus on the training provided during the week of March 28" 2016 specific to understanding
and using the MDT-Desktop. Two different groups of people attended the trainings (see Attendees
section of this report): federal and provincial government employees (i.e. MEGD & Aimag
Enviornmental Agencies responsible for EIA law in Aimag), and private mining and environmental
companies required to comply with the offset regulation. This required one-day classroom trainings
occhurring on two separate days for government employees (March 30”‘) and private employees (March
29").

Objective of Trainings

For the one-day trainings, we had one overall objective of providing users with the knowledge and
expertise to be able to use both the MDT-Desktop and MDT-Web. We accomplished this by providing
one lecture, two demonstrations, and three exercises. All of the exercise required students to either use
MDT-Desktop tool directly within ArcGIS or use QGIS to prepare and upload data to the MDT-Web. All
exercises were also translated to Mongolia prior to the trainings.

Unit 1 — MDT Background
* Lecture — Background on MDT
* Exercise —None

Unit 2 — MDT-Desktop
* Demonstration — Demonstrated how to apply the MDT-Desktop.
* Exercises — Students used ArcGIS and the MDT-Desktop toolbox to calculate offset requirements
and go through modifying a fake mine plan to address avoidance areas.

Unit 3 — MDT-Web
* Demonstration — Demonstrated how to use the MDT-Web application.
* Exercise — Students used QGIS and MDT-Web to calculate offset requirements and identify
avoidance areas.

Course Materials

All students received a USB drive with documents, data, tools, exercises and presentations.
Presentations and exercises were provided in both English and Mongolian. This allowed for students to
share all information with others and have the ability to perform the exercises at later dates. The USB
had four main directories named Documents, Exercises, MDT_Mongolia, and Presentations. The
Documents directory contained all documents currently created for this effort, both in English and
Mongolian. The Exercises directory had a series of MXD files associated with each exercises, data used
in the exercise and all the solutions to the exercises. The exercises without solutions and translated
were handed out as paper copies to each of the students to make it easier for them to do the training.
The MDT_Mongolia directory was the folder containing the MDT-Desktop which was used in the first



two exercises. This directory also contained help documentation for the tool both in English and
Mongolian. The Presentations directory had all the presentations used for the lecture.

Class Evaluations
All those attending the one-day trainings were asked a series of questions at the end of the training to
gain feedback and evaluate our performance.

Questions Asked
1) What was most important with the training?

2) What was least important with the training?

3) What would you remove from the training?

4) Were the exercises helpful and why?

5) Are there items you would change with the exercises?

6) Do you feel you can now successfully calculate a yearly offset cost as defined by the Mongolia
Offset Regulation?

7) If you answered no to question 6, please explain why?

8) From 1 (lowest) to 10 (highest) please rank the value of the training?

9) Have you heard the MDT before?
10) Will you use this tool further?

Responses
MDT Training March31-Aprill, 2016 ----- Company Feedback

1) What was most important with the training?

* Exercises were important.-2

* Definition of Impact area

* Theory and practice. -2

* Training was helpful and GIS method for offset analysis and MDT were very important-2
*  Working with the tool and data support.

* Exercises

¢ Calculation, practice work, data support including tools and useful documents.
* MDT web version -2

* |learned how to identify offset areas and cost report using disturbance data.

* MDT tool

¢ All things were useful.

e Tutorial and demo.

2) What was least important with the training?
* n/a-14
* Firstintroduction

¢ Other questions not related training



3)

6)

7)

What would you remove from the training?
n/a-16
Need to improve the training and include more officers and participants.

Reduce lecture time

Were the exercises helpful and why?

Because | work at the EIA company

Yes, it was helpful because | can work according to the practice next time.

Yes-5

Exercises and examples were important.

Very helpful. | will use this tool with project assessment.

Helpful. When | used this tool before at my office | had many questions but now | got answers
by attending this training.

| did exercises more careful because all exercises were having questions. | tried to understand
more based on these Q/A.

It was easy to understand.-2

Very helpful. Now | can work by myself further.-2

It was helpful because | did exercises.

Now, this tool seems to me easier.

Are there items you would change with the exercises?

N/a-12

It is better If exercises were managed from the main PC.

All students can practice with the tool using different projects and then ask and compare their
problems.

Need to clarify main data (ecological factors).

| think it was helpful if we used different data from different locations.

Maybe.

Do you feel you can now successfully calculate a yearly offset cost as defined by the Mongolia
Offset Regulation?

| can if | use help documents.

| can if any errors would not occur.

Yes, | can-11

| can after practicing many times.-2

If you answered no to question 6, please explain why?



8)

9)

From 1 (lowest) to 10 (highest) please rank the value of the training?
1 2 3 4 5 6 7-2 8-4 9-2 10-9

Have you heard the MDT before?
* No-7
* | have known because participated previous training -2
* | have heard but did not use with GIS software.

* Yes

10) Will you use this tool further?

*  Yes—1 (mining company)

* Yes-11 (EIA companies)

MDT Training March31-Aprill, 2016 ----- Feedback from Aimags and MEGD

1)

2)

3)

4)

What was most important with the training?

Practice to use MDT. -4

A chance to learn MDT for EIA officers who is responsible for receiving offset report.
Got understanding about MDT with the help docs.

Automatic calculation.

Identifying of potential offset areas, mitigation design, rehabilitation.

Monitoring of offset procedures of companies using MDT

Offset procedure and MDT.

It was important that MDT web is created to calculate impact area.

Training was very efficient.

Offset procedure including cost report and offset location using modern software.
This training is important for EIA. Thank you very much. Success!

Practice and exercises with MDT versions.

What was least important with the training?
* n/a-15

* Training was hard to understand.

What would you remove from the training?
n/a-15
law implementation related mitigation.

The presentation that provided during previous training.

Were the exercises helpful and why?

Yes, it was useful - 5



6)

7)

8)

9)

Very helpful. | will use this tool for my everyday work. -4

It was easy to learn because of exercise work with real cases.
It was helpful but | am late.

It was helpful because we worked with the tool.

| asked some unclear things and got an answer.

Exercises were helpful and we asked questions directly.

Are there items you would change with the exercises?

Need to reduce data.

n/a-11

Need to extend exercise time.

If it was including local protected areas it would be more useful. If the government confirm
some offset procedures we will follow. For example: offset unit 5 S.

This tool and procedure documents must include offset implementation method of EIA report.
Need to make a plan. If disturbance of exercise data was overlapped with restricted areas, it
would be more helpful.

Need to improve more.

Do you feel you can now successfully calculate a yearly offset cost as defined by the Mongolia
Offset Regulation?

| can use it after doing exercises well. -2

Yes, | can.-9

If | use help documents | can.

Confusing.

Need more practice.

If you answered no to question 6, please explain why?

From 1 (lowest) to 10 (highest) please rank the value of the training?
1 2 31 4 5-1 6 7 8-2 9-5 10-6

Have you heard the MDT before?
* No-5

10) Will you use this tool further?

* Yes-5



Location of Training
One-day trainings: National University of Mongolia, GIS Lab — Dr. Bolorchuluun

Attendees
Participants: EIA and Mining companies
Total 22 people

No | Name ‘ Title Company Phone Mail address
EIA companies
1 Narangarav Environmental officer EHSM XXK 99937188 ehsmmongolia@gmail.com
2 Turmunkh GIS officer TECOL XXK 95229000 tecol_77@yahoo.com
3 Delgermaa Environmental officer Ekh Mongoliin Baigali LLC 95343439 deegii_emb@yahoo.com
4 Davaasuren Environmental officer EACC XXK 99138170 davaasuren.eacc@gmail.com
5 Altansukh Lecturer and director Eco Tushig Khugjil LLC 91993096 altansukh22 @yahoo.com
6 Zayatogtokh Environmental officer MECS XXK 98113163 mecszb.company@gmail.com
7 Chintuul Environmental officer Gazar chandmani LLC 99983397 chintuul_Iff@yahoo.com
8 Davaajargal Environmental officer Mon Gazar Ecology LLC 86007706 davkabold@yahoo.com
9 Byambatseren | Environmental officer Eco Serivice LLC 99076414 byambatseren@gmail.com
10 | Ochmaa Executive director Qi Bus LLC 99099961
11 | Chimegbayar Environmental officer Asian ecologic resource LLC 99811720 chimegbayar90@gmail.com
12 Erdenebat Environmental officer Underkhaan trade LLC 88076774 erdenebat.batsaihan@gmail.com
13 | Nyamsuren Environmental officer Mon gazar ecology LLC 96565373 nyamsuren.eco@gmail.com
14 | Uransaikhan Environmental officer Eco Ton LLC 99222100 )
15 | Erdenebat Environmental officer Eco Service LLC 86110016 eba0504@yahoo.com
Mining companies
16 | Anudari Environmental officer Oyu Tolgoi LLC 99773647 anudarig@ot.mn
17 | Iderkavkhlan GIS officer Energy Resource LLC 88000455 iderjavkhlan.s@mmc.mn
18 | Ichinnorov Environmental officer MMC LLC 99054015 g _chinee@yahoo.com
19 | Narangerel Environmental officer Boroo gold LLC 99820788 Narangerel.S@centerragold.mn
20 | Buyan-Ulzii Environmental officer Numan Altai LLC buyanulzii@numan.mn
21 Environmental officer Mongoliin ecologiin 91918376
Enkhbold nootsiin san LLC yavaadirlee@gmail.com
22 | Davaatseren | GIS officer MAK LLC 99003531 mdavaa@mak.mn
March 31, 2016
Participants: Aimag staff and MEGDT
Total 27 people
No | Name Title Province Tel Mail
1 Tserenlkham EIA officer Arkhangai 98115529
2 Naranbaatar EIA officer Bayankhongor 99048004 naraa_83@yahoo.com
3 Mart EIA officer Bulgan 99443495
4 Jargaltsetseg EIA officer Gobi-Altai 99029980
5 Amkh-Amgalan EIA officer Gobisumber 89008524 amgaa518@yahoo.com
6 Batmunkh EIA officer Darkhan-Uul 99407644
7 Bolormaa EIA officer Dornogobi 99043151




Erdenebayar EIA officer Dornod 88007804 )

Ankhbayar EIA officer Dundgobi 88059031 ankhaa0217kh@yahoo.com
10 | Enkhee EIA officer Zavkhan 91669229 nh1006b@yahoo.com
11 | Odonchimeg EIA officer Orkhon 99024732 odnoo_0527@yahoo.com
12 | Boldbaatar EIA officer Uverkhangai 99948990 nt_boldoo@yahoo.com
13 | Orgilmaa EIA officer Umnugobi 99074877 orgio 78@yahoo.com
14 | Nyamkhuu EIA officer Sukhbaatar 96899366 nyamkhuusharkhuu@gmail.com
15 | Oyun-Erdene EIA officer Selenge 99492050
16 | Dash-Yachil EIA officer Tuv 88050200
17 | Bilguun EIA officer Uvs 96449940
18 | Ariundolgor EIA officer Khovd 99859438 b _ariuka270@yahoo.com
19 | Unenbat EIA officer Khuvsgul 99411414 khuvsgul _boa@ymail.com
20 | Munkh-Erdene EIA officer Khentii 96480704 muugii_best@yahoo.com
21 | Batsukh EIA officer small Gobi 88030903 batsuh44@yahoo.com
22 | Batdorj EIA officer TNC 97185888 batdorj72@yahoo.com
23 | Otgontugs GIS officer MEGDT 99190844 otgontugs@mne.gov.mn
24 | Erdenekhu GIS officer MEGDT 99248887 erdenekhuu_e@yahoo.com
25 | Javzandulam GIS officer MEGDT 88020617 b.jawzaa86@yahoo.com
26 | Ankhbayar GIS officer MEGDT 266312
27 | Buyannemekh Director of ET Dornogobi 99084657 g nemehee@yahoo.com




Recommendations and Future Training

Training with regards to the MDT will continue to be important as the MOR is implemented. After the
EBRD project is completed however it will be important for MEGD to identify someone or some group
such as TNC Mongolia responsible to continue to educate potential users. All teaching materials created
for this effort are open to any to use with full rights to update, modify and adapt any of these training
materials in the future. Additionally all training materials will be on-line allowing for users to learn how
to apply the MDT on their own.

One item that became apparent when teaching the provincial EIA officers is there is a lack of skill and
knowledge on how GIS can be used to help them do their jobs. This will lead to many of the Aimag
officials not being able to fully interpret the output from the MDT. With the html report, they will have
full understanding on the yearly offset compensation value however taking the next step on identifying
what to do for offsetting and where may be difficult. Further work needs to be done with these folks to
help them fully understand how to use output from the MDT in order to work with the companies and
develop a fair and appropriate offset stipulations. Additionally further GIS training would be
appropriate helping these folks understand how to better use available data for their jobs.



Appendix A - Attached Exercises with Answers

Exercise #1
Exercise 1a — Setup of MDT and Training

O

O

Place external drive into USB port and make sure your computer can read the external drive.

Open a new session of ArcMap use the Customize menu and select Extensions. Make sure there
is a check in front of Spatial Analyst, if not check this box.

Use the Catalog window to create a new folder connection to the MDT_Training folder on your
external drive.

Expand the MDT_Mongolia folder, how many toolboxes are within this directory? 2

Open the ArcToolbox window (e.g. click on Toolbox button ). Within this window, right click
on the top item named ArcToolbox and select Add Toolbox. Select the folder you mapped
above and open the MDT_Mongolia folder. Select the MDT Toolbox (i.e. MDT.tbx) and click on
the Open button.

This should add the toolbox MDT to your list of toolboxes. Now again right click on the top item
named ArcToolbox and select Save Settings>To Default. This adds the toolbox to future ArcMap
sessions.

Expand the MDT toolbox. How many toolsets are within this toolbox? 4

Expand the Update Tools toolset and double click on the Check for Application and Database
Updates tool. Place a check in front of Access updates, if needed. Click the OK button. Is your
MDT database current? yes

Expand all the other toolsets within the MDT toolbox. Which toolset has the most tools? Land
Disturbance and Impact Tools

Using the Catalog window, create a new folder with the name MDT_Output on a local drive
having read/write permissions (e.g. C:\MDT_Output). You will use this folder for all the data and
files generated with the MDT tool.

Exercise 1b — Identifying Offset Costs and Potential Locations.

O

O

Using the current ArcMap session open EX1.mxd (i.e. File>Open menu) within the
MDT _Training/Exercises folder.

You will see three layers; Land Disturbances-Linear, Land Disturbances-Area and Fake Mine Plan.
The Fake Mine Plan is a plan which was never developed however it has been geo-referenced to
simulate a potential mining plan within the Gobi region.

Using the measure tool , what is the approximate area in KM? of this planned development?
Answers will vary but roughly 5-7 km?



If you were going to digitize the land disturbances of this site plan with ArcMap, the first step
would be to create land disturbances data using the Stepla — Create Land Disturbance Data
tool. Open the ArcToolbox window and select the MDT toolbox and open this tool.

Select your MDT_Output folder for a project Folder Location and keep the default setting for the
rest of the tool.

g h'

=" Step 1a - Create Land Disturbance Data 2 | 5 it

Project Folder Location

C:\MDT_Output B
Linear Land Disturbance Feature Class Name

LD_Linear
Area Land Disturbance Feature Class Name

LD_Area

[¥] Display Cumulative Offset Factor and Development Restriction Layers

[ oK ] [ Cancel ] [Environments... ] [ Show Help >>

Click the OK button.
How many layers are added to ArcMap? 8

Make visible all layers within the group layer Development Restriction Areas. Are there any
mapped development restrictions in this area? No

The Cumulative Offset Factor layer gives users the ability to see estimate ratios for offset
requirements while creating your land disturbance layers. This allows user when presented with
options to choose lower offset cost areas to develop. Place this layer below the Fake Mine Plan
layer. Which land disturbance appears to have the potential for the highest offset cost?
Overburden Piles in the south part of the planned development

Remove all Development Restriction Area layers and Cumulative Offset Factor layers from
ArcMap.

Using the Catalog window, navigate to the MDT_Output folder, right click on
mdt_land_disturbances.gdb and select the Properties menu. Click on the Domains tab in the
Database Properties window. How many domains are associated with this file geodatabase? 2

How many coded values are available for the MDT_LD_Area_Domain? 19

Close the Database Properties window and display the layer properties associated with the
LD_Area layer by right clicking on the layer name in the ArcMap Table of Contents and selecting
the Properties menu. Click on the Fields tab within the Properties window and select the
LD_Code field by clicking on its name in the list of field names. What is the name of the Coded
value domain associated with this field? MDT_LD Area_Domain



What field will therefor contain your land disturbance codes associated with the MDT? LD_Code

Now click on the Source tab within the Layer Properties window. What projection has been
assigned to these data? UTM Zone 48 North using the WGS 1984 datum

Remove the LD_Linear and LD_Area layers. Normally you would use these datasets to begin
digitizing land disturbances however they have already been digitized for you and are named
Land Disturbances — Linear and Land Disturbances — Area.

Now to check these datasets which have already been digitized, we will run the Step 1b — Check
Land Disturbance Data tool. Open this tool within the MDT toolbox. Input the appropriate
values within this dialog. It should look exactly like the dialog below.

( 5" Step 1b - Check Land Disturbance Data E@I-g_hjw
Land Disturbances - Linear Features (optional) 1
ILand Disturbances - Linear LI
Field Name for Land Disturbance Type - Linear Features (optional)

LD_Code v
Land Disturbances - Area Features (optional)
ILand Disturbances - Area L]
Field Name for Land Disturbance Type - Area Features (optional)

LD _Code v

" [ OK ] [ Cancel ] [Environments...] [ Show Help >>

How many errors were found within Land Disturbances — Linear layer? 3
How many errors were found within Land Disturbances — Area layer? 8

Basically none of the attributes have been assigned. We will now fix these errors by attributing
features which caused the errors. Make the Land Disturbances — Linear layer the only visible
layer.

- . .
Start a new edit session. This can be done by clicking on the Editor button === which displays
the Editor Toolbar. Then by clicking on the Editor menu and selecting the Start Editing menu,
you will start an edit session.

Add the Attributes editing window by clicking on the Attributes button @] on the Editor
Toolbar.

Now use the Editor Selection tool '™ and select the main road running on the West and North
side of the planned development. Within the LD_Code field click on the dropdown menu and
select Roads-Paved.

Assume the other linear features are Roads — Improved Dirt and code them following the same
procedure as above.



0 Save your edits by clicking on the Editor menu and selecting Save Edits. Clear all select features.

[0 Now make visible the Land Disturbances — Area and Fake Mine Plan layers. Follow the same

procedures but this time select polygons and assign the appropriate land disturbance codes to
these area features. If the Fake Mine Plan map is difficult to read, use the following guide:
Light blue — mine pit
Light brown — overburden piles
Dark green — growth media piles
Blue — heap leach pads
Dark brown — processing facilities except for the one nearest the entrance which is an
office facility

[0 Save your edits, clear all selected features, and stop your edit session by clicking on the Editor

menu and selecting Stop Editing.

[0 Now display each layer setting the symbology of each to use LD_Code field with a Unique Values

O

categorization. Look at the screen capture below, your colors may be different but your ArcMap
display should look similar with the layers overlapping all the land disturbances found in the
georeferenced site plan. NOTE: Due to the Domain Codes associated with the LD_Code
attributes, ArcMap automatically adds a legend with all possible domain codes. You will need to
remove from the symbology those disturbances which are not part of this planned

EX1aAttributed.mxd -

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

Dep@a& B x |0 | b-|125462 ] EEE O Fe g ¢ Ediore [n ] Kh:hx2BAIEg

@ @ & m @ - CEaB QU@ es K- OI8O 7 E2IMHS Ry
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If you missed one start a new edit session and attribute the feature you missed and save your

edits.




[0 Now to double check our work, we will run the Step 1b — Check Land Disturbance Data tool.
Open this tool within the MDT toolbox. Input the appropriate values within this dialog. It
should look exactly like the dialog below.

s
= Step 1b - Check Land Disturbance Data ‘ E=NEERT)

Land Disturbances - Linear Features (optional)
ILand Disturbances - Linear |

Field Name for Land Disturbance Type - Linear Features (optional)

LD_Code v
Land Disturbances - Area Features (optional)
| Land Disturbances - Area ~|
Field Name for Land Disturbance Type - Area Features (optional)

v

ok || cancel | |Environments... || ShowHelp >>

0 You should have received a message saying: “There were no errors or warnings with your data.
These data can be run successfully with the Step 2 — Calculate Project Impact tool.”

[0 Open the Step 2 — Calculate Project Impact Area tool within ArcToolbox>MDT>Land
Disturbance and Impact Tools. Set the Land Disturbance - Linear layer as the Land Disturbances
— Linear Features and select the LD_Code field for the Field Name for Land Disturbance Type.
Set the Area Features to the Land Disturbance - Area layer and select its LD_Code field for the
Field Name. Finally name the Project Impact Raster Dataset as Ex1Projectimpact.img making
sure to locate this output to your MDT_Output folder. Your dialog should look the same as the
one below. NOTE: Make sure none of the land disturbance features are selected before running
the tool.

oz e T e

Land Disturbances - Linear Features (optional)

lLand Disturbance - Linear LI @
Field Name for Land Disturbance Type - Linear Features (optional)

LD_Code v
Land Disturbances - Area Features (optional)

N &
| Land Disturbance - Area ~|
Field Name for Land Disturbance Type - Area Features (optional)

LD_Code v
Ouptut - Project Impact Raster Dataset
C:\MDT_Output\Ex 1Projectimpact.img

-

[ OK ][ Cancel ][Environments...” Show Help >> ]

0 Click the OK button. Hint: This took my computer approximately 3 minutes so grab a short
break while this is running.



[0 Examine the output impact raster, Ex1Projectimpact.img and answer the following questions:

o What is the resolution of the dataset (Hint: use the source tab within the layer
properties dialog)? 10 m

o Which impact area covers the largest area (Hint: open attribute table and select the
impact with highest cell count)? 30-High Impact

o How many sq meters does the high impact category cover (Hint: resolution * resolution
* cell count)? 5,661,100m’ or 5.661 km?

[0 With the project impact area calculated, we can now calculate the potential offset costs associated
with this development. Open the Step3 — Calculate Offset Cost Report tool within
Toolbox>MDT>Offset Tools. Set the Project Name to Oakleaf, select the Ex1Projectimpact.img layer
for the Project Impact Area Raster, set the Project Duration to Medium (5 — 20 years) and finally set
the output file name to Oakleaf Report.html. Your dialog should look exactly like the one below.

'd A
5[ Step 3 - Calculate Offset Cost Report E‘E‘éj

Project Name

Oakleaf
Project Impact Area Raster
| Ex1Projectlmpact.img LI
Project Duration

Medium (5 - 20 years) v
HTML File OQutput

C:\WMDT_Output\Oakleaf_Report.html E;«

OK ] [ Cancel ] [Environments... ] [ Show Help >>

O Click the OK button.

[0 Using the report generated, scroll through it and answer these questions:

O 0 O 0 ©

o
o

What is the total offset cost per year for this project? $25,370

What is the total offset units per year for this project? 5,074

What are the total hectares of the area impacted? 1,016.38ha

What is roughly the overall offset ratio for this project? 5to 1

Which offset factor (i.e. Ecosystem Category, Habitat Type, Landscape Condition, Landscape
Priority, Project Duration) contributed the most to the overall offset cost? Habitat Type &
Landscape Priority — 1,353 offset units

What Soum are these impacts located in? Xu’rmen Soum

What is the ecosystem impacted by this development? Semi Desert

0 Now to identify where best to potentially apply these offset actions, Open Step 4 (optional) —
Identify Potential Offset Sites within MDT>Offset Tools. Select the Ex1Projectimpact.img as the
Project Impact Area Raster, select your MDT_Output folder as the Output Folder and keep both
items checked. Your dialog should look the same as below.
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Project Impact Area Raster
lEleroject[mpact.img LI
Qutput Folder
LA
C:\MDT_Output

Identify Potential Offset Sites within Aimag Impacted

Identify Potential Offset Sites within Soum Impacted

-

lg‘ [ OK ] [ Cancel ] [Environments... ] [ Show Helpﬂ

Click on the Ok button.

How many potential offset sites were selected within the Xu’rmen Soum ? 3

Open the attribute table of the OffSites4_Xu-rmen_Soum_inGobi layer, using the dist_away field
identify by the AREANAME field the closest potential offset site for the project impact area? Tavan
suhain hundii

How many potential offset sites can be found within O’mnogovi Aimag? 18

Open the attribute table of the OffSites4_O_mnogovi_Aimag_inGobi layer, using the dist_away field
identity the AREANAME of the closest potential offset site for the project impact area? Tavan
suhain hundi

How are these two potential closest offset sites different?

The Tavan suhain hundii site within the OffSites4_O_mnogovi_Aimag_inGobi includes the entire

expert site while the other only includes those lands located within Xu-rmen Soum.

Close ArcMAP without saving.



Exercise #2

Exercise 2— Avoidance

O

O

oo

Open EX2.mxd within the MDT_Training/Exercises folder

Open the Oakleaf Fake Mine — Linear Land Disturbance attribute table. Write down how many
features are found in this layer. 4 (features don’t always match the legend for example there
are two different improved dirt roads within this layer)

Open the Oakleaf Fake Mine — Area Land Disturbance attribute table. Write down how many
features are found in this layer. 5

Open the ArcToolbox window and select the MDT toolbox. Under the Land Disturbances and
Impact Tools, double-click on Step 2 — Calculate Project Impact Area.

Select the Oakleaf Fake Mine —Linear Land Disturbances for the Linear Features and the
LD_Code field for the Field Name. Do the same for Area Features using the Oakleaf Fake Mine —
Area Land Disturbances layer for the input. Finally set the Output to the name
Oakleaf_Project_Impact.img and place it within the MDT_Output folder. Your dialog should
look similar to the one below.

={ Step 2 - Calculate Project Impact Area‘ [EI@[Q‘
Land Disturbances - Linear Features (optional) I
I Oakleaf Fake Mine - Linear Land Disturbances Ll
Field Name for Land Disturbance Type - Linear Features (optional)
LD_Code -
Land Disturbances - Area Features (optional) I
IOakIeaf Fake Mine - Area Land Disturbances L] i
Field Name for Land Disturbance Type - Area Features (optional) |
LD_Code -
Ouptut - Project Impact Raster Dataset '
C:\MDT_Output\Oakleaf_Project_Impact.img
I
[ OK ] [ Cancel ] [Environments. - ] [ Show Help >> ]

Click the Ok button to run
Examine the output dialog as this tool runs. It will inform you as each LD feature is used in
creating a Project Impact Area

If you drink coffee or tea, this would be a good time to go and get it ©



[0 Once the application is finished write down how long it took to calculate the project impact area
for these disturbances. Will vary but ran for 10 minutes on my computer.

[0 Make the Oakleaf Project_Impact.img the only visible layer and open its attribute table. Which
impact category has the most area associated with it? 10-Low

0 Within the MDT Toolbox under the Offset Tools select the Step 3 — Calculate Offset Cost Report
tool and set Project Name to Oakleaf Fake Mine, select the Oakleaf Project_Impact.img layer
for the Project Impact Area Raster, select Medium (5-20 years) for Project Duration, and output
the HTML File to your MDT_Output folder naming it Oakleaf.html. It should match the dialog
below.

Step 3 - Calculate Offset Cost Report ‘ E‘@Iﬂw
Project Name 1
Oakleaf Fake Mine
Project Impact Area Raster
l Oakleaf_Project_Impact.img LI
Project Duration
Medium (5 - 20 years) v
HTML File Output
C:\MDT_Output\Oakleaf.html
OK ] [ Cancel ] [Environments... ] [ Show Help >> ]

O Click the OK button
[0 Examine the output dialog as the tool runs
[0 When the report opens, scroll through it and answer these questions:
o What is the total offset cost per year for this project? $212,490
o What are the total hectares of the area impacted? 9,477.48 ha
o What is the percent of impacts found within Xovsgol Soum? 0.31%
o What is the ecosystem which is most impacted within Ulaanbadrax Soum? Desert

steppe

0 We are now going to look at ways to lower the costs associated with this project. Open the Land
Disturbances — Locational Offset Cost and Restrictions Assessment Tool found within



ArcToolbox>MDT>Supplementary Avoidance Tools. Input the appropriate values and output your
Assessment to the name LC_CostAssessment.shp. Keep default items checked. Your dialog should
look like the one below.

[ 5" Land Disturbances - Locational Offset Cost and Restrictions Ass... @ﬁg‘
Land Disturbances - Linear Features (optional) |
|Oakleaf Fake Mine - Linear Land Disturbances LI
Field Name for Land Disturbance Type - Linear Features (optional)

LD_Code v
Land Disturbances - Area Features (optional)
lOakIeaf Fake Mine - Area Land Disturbances Ll
Field Name for Land Disturbance Type - Area Features (optional) ‘
LD_Code v
Assessment Output
C:\MDT_Output\LD_CostAssessment.shp

Show total project summary

Add Cumulative Offset Factors and Development Restrictions Layers

[ OK ] [ Cancel ] [Environments...] [ Show Help >>

Click on the OK button.

How long did this tool take to complete? Answers will vary but it was only 40 secs for me

What was the total summary COF value for all land disturbances (Hint: This is displayed in the
geoprocessing results dialog)? 83,102

Which two disturbances result in the highest offset costs? 1) Road — Dirt multi-track and
2)Temporary Camp

Comparing the Temporary Camp with the Cumulative Offset Factors, what could you do to lower
your offset costs with this land disturbance given it must stay connected to the same road?

Move it to the west to place the entire feature and 1000 meter buffer completely within the green
area.

List any other potential spatial modification which could lessen offset costs?

1. Design multi-track road go straight east to main road

2. Create only one road

3. Move the temporary camp to the east side of the project area.
etc

Are there any land disturbances crossing development restriction areas?
Yes, the transmission line, temporary camp, all roads



[0 Close ArcMap without saving.

O

Now open EX2_modified.mxd.

[0 The land disturbance features were modified, list the changes you see:

o O 0O 0O

o Moved the Temporary Camp to the west making sure the camp is to the west enough to
completely have its impact area within the green area (i.e. COF value of 6.2) of the
Cumulative Offset Factors.

o Now only one road.

o Transmission line runs next to the single road.

Now rerun the Land Disturbances — Locational Offset Cost and Restrictions Assessment using the
modified land disturbances and assign the name of your assessment output to Modified.shp. This
time uncheck the Add Cumulative Offset Factors and Development Restrictions Layers. Your dialog
should look similar to the one below.

[ 5" Land Disturbances - Locational Offset Cost and Restrictions ... E@‘g\
Land Disturbances - Linear Features (optional) 1
| LD_Linear_Modified |
Field Name for Land Disturbance Type - Linear Features (optional)

LD_Code -
Land Disturbances - Area Features (optional)
| LD_Area_Modified LI
Field Name for Land Disturbance Type - Area Features (optional)

LD_Code v
Assessment Output

C:\WDT_Output\Modified.shp

Show total project summary

[ Add Cumulative Offset Factors and Development Restrictions Layers

E [ OK ] [ Cancel ] [Environments...] [ Show Help >> ]

Click the OK button.
What is the new overall COF value? 46,042
Which land disturbance feature now has the highest potential cost value? Mine pit

Now go through the steps and use the appropriate tools to create an offset cost report for these
modified land disturbances.



What is the new total offset cost per year with the modified land disturbances using the same
duration values as before (i.e. Medium)? $ 147,320

How much did that save in offset costs? Roughly $65,170 /year

Would there still be other ways to possibly save additional offset cots?

Possible Answers:
o Make the parking lot smaller and within some of the buffered mine pit impacts
o Have parking lots adjacent to the temporary camp.

Close ArcMap without saving.



Exercise #3

Exercise 3— QGIS and MDT Web

O
O

O 0O oO0

oo

Open Ex3.qgs within the MDT_Training/Exercises folder
Use QGIS to answer the following questions.
o How many area land disturbances are there? 25
o Which land disturbance is most present in this table? Office Facilities
o Just by looking, what type of area disturbance will modify the land the most? Piles
o Roughly what is the total size of the area disturbed? Answers will vary between 13 — 16
km2
o What is the size of the mining pit? 1.342 km2
o How many linear land disturbances are found at this site? 8
Close Ex3.qgs without saving
We are now going to use the MDT Web to examine avoidance needs and lower overall offset
costs required for this site.
Using your favorite browser window open the following url:
http://s3.amazonaws.com/DevByDesign-Web/MappingAppsVer2/MDT_Mongolia/index.html
Before running any MDT Analysis, use the web site to answer the following questions:
o How many map tools are available? 10
o How many input data maps are included? 7
o Turn on the Local Protected Areas layer and the Aimag Boundaries layer. Just by looking
which two Aimags have the highest percent of their land designated as locally
protected? Bayanxongor and O'vorxangai
o What year was the Local Protected Areas layer created (Hint: Click on info button to the
right of the layer name)? 2015
o Zoom to a Latitude of 47 and Longitude of 93, answer these questions:
=  Which ecoregional assessment boundary is this location in? West-Central
= What ecosystem type is found at this point? desert steppe
We will now use the MDT Analysis tools, how many tools are available? 3
Click on the Upload Land Disturbances Data tool. Click on the Browse button and select the
zipfile FakeGoldMineEx3.zip located in your Exercises folder. Before running the tool, identify
the Aimag this fake development scenario is located in. Xovd
Now make sure the LD Code Field names are set to the field name DCode for both Area LDs and
Linear LDs and then click on the Run LD Check button. How many errors are identified by the
tool? 2
Close the Upload and Check Land Disturbance Data dialog. What color are the error features?
Red
Examine the legend to the left, are there some features which seem misidentified, if so identify
which ones?
Pipeline is actually a paved road. The mining pit is identified as an Airport feature. An
additional airport feature is identified in the large polygon on the western part of the
development.
We will now fix all the attribute errors with these data:
o Click on the linear error feature, what is the current LD_Code for this feature? 0
o Click on the Edit LD Code button, select from the drop-down menu Roads-Improved Dirt
and then click on the update button.
o Close this dialog. What color is this feature now? Black




o Click on the polygon error feature and set this feature to a Pile.

Change the Pipeline linear land disturbance to a Roads — Paved.

o Click on the Airport area feature in the south-eastern quadrant of the planned
development and change this feature to a Mining Pit

o Click on the Airport area feature in the western portion of the planned development
and change this feature to a Pile.

o Your web map should look similar to the one below:
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Click on the Avoidance Analysis menu. Identify the color of the icon following step one. Red
Now to check your attribute edits, re-open the Upload Land Disturbances Data dialog.

Click on Run LD Check and make sure the output does not identify any errors. If it does go back
and make sure that you followed the attribute edits necessary to match the map above and
then Run LD Check again.

With these land disturbances displayed, now turn on the Cumulative Offset Factors layer.
Identify which features look to be the most costly to offset? Those in the orange on the western
portion of the planned development.

Turn on the Landscape Priority factor map, what category does this planned development fall
into? High

Using either the layer information or other input data maps, identify why this planned
development falls into this category? It is within a proposed National Protected Area.

We will now check our assumptions by running the MDT Avoidance Analysis. Click on the
Avoidance Analysis menu. Now what icon is found to the right of step one? Green check mark.
Input an email account you can access via the computer you are currently assigned to. (Note: If
you can’t access your email on your assigned computer just type in your own email account and
check files later when you return to work, you can access a replica of the output zip file (i.e.
mdt_avoid_data_originalEx3.zip) under the Data>Ex3>output folder ).

Depending on the current web traffic and processing que of the application server this process
could require some wait time.
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When you received the email, who was the sender of the email containing the avoidance data?
dybd.tnc.apps@gmail.com
What is the name of the attached file? mdt_avoid.data.zip
Open the attached file and identify how many files are withinin this zip file? 8
Click on the total_summary.txt to open. What is the cumulative offset factor value of this
development? 20,457
Minimize your web browser window and now open Ex3b.qgs.
Using the Id_avoid layer and its attribute table answer the following questions:
o How many impact areas from the disturbances (i.e. Id_avoid) are placed in the high
category for the average costs? 5
o Where are these high category impacts located within the planned development?
Western portion.
o Of these high categories how many of them derive from area disturbances (Hint: LinkID
relates to the type of disturbances and the original disturbance feature id)? 3
o Which land disturbance feature ranks the highest for its offset costs? Mining Pit
o Do any of the impacts overlap a protected area? No
o What restricted areas do the impacts overlap? Riparian areas
Close Ex3b.ggs without saving.
Maximize your web browser with MDT — Web open. We will now load a different mine plan
which avoids some of the higher cost areas. Click on the Upload Land Disturbances Data menu.
Which zip file is it currently using? FakeGoldMineEx3.zip which has modified attributes
Click on the Browse button and select the zip file FakeGoldMineEx3Avoid.zip located in your
Exercises folder.
Set the LD Code Fields to Ld_Code and click on the Run LD Check button. Where there any
errors? No
Identify some of the changes you see with this new impact design?

Since we now have a final design for our planned development, we will now run the Offset
Analysis. Click on the Offset Analysis menu.
Set the project life to Medium (5-20 years), input any project name you want, and again input an
email account you can access from your current computer. Click on the Run Offset Analysis
button. Note: If you can’t access your email on your assigned computer just type in your own
email account and check files later when you return to work, you can access a replica of the
output zip file (i.e. mdt_offset_data.zip) under the Data>Ex3>output folder.
While the application is running, open the replica zip file(i.e. mdt_offset_data.zip, under the
Data>Ex3>output folder) and answer these questions:
o How many files are within this zip file? 35
o Open the mdt_offset_cost.html file and answer these questions:
=  What is the total offset costs per year for this development? $70,620
=  Which offset category had the highest number of offset units required? Either
Habitat Type or Landscape Priority
= Within which Soum do all the impacts occur? Mo'st
= What are the total hectares impacted by this planned development? 1,862



oo

=  Which ecosystem type is most impacted by this planned development? Desert
steppe
o Open the offset_info.txt file and answer these questions:
=  What three shapefiles within the zip file identify potential offset locations?
OffSites_In_West_ERA.shp, OffSites4_Xovd_Aimag_inWest.shp,
OffSites4_Mo_st_Soum_inWest.shp
= How many offset sites did the application identify for Xovd aimag? 2
Close the replica zip file.
Open Ex3c.qgs which display the output data from the MDT-Web offset analysis and answer the
following questions:
o Which impact category is the largest in terms of area? High
o Which offset site is the closest to this development? Baatar hairhan
o What is the category of the offset site closest to the development? Proposed NPA
o What is the name of the next closest identified offset site within the Aimag? Sutai
hairhan
Close Ex3c.qgs



